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Definitions

SCAP (S-CAP) — “Security Content Automation Protocol” is a standard
way of documenting server configurations and descriptions of malware
iIn a machine readable form. A suite of XML document specifications
and other standards used to develop a common way to assess
compliance and vulnerability issues.

XML- eXtensible Markup Language

OVAL — Open Vulnerability and Assessment Language: Standard XML
based language for expressing the necessary logic to check for
vulnerabilities, compliance, installed software and patches.



XCCDEF- Extensible Configuration Checklist Description Format. Itis
XML for specifying checklists and for reporting results of checklist
evaluation. An XCCDF benchmark defines a number of rules who
generally reference definitions in an OVAL.xml document.

CPE- Dictionary.xml- A dictionary consisting of two files, a CPE-
Dictionary.xml and CPE OVAL.xml. CPE-Dictionary.xml contains
targeted platforms and references the file containing the platform
iInventory definitions/checks.

CPE- OVAL.xml- Is an accompanying file of the CPE Dictionary.xml
file. It includes the platform OVAL check(s) for determining applicability
of the benchmark definitions.



Malware Content
Editor (MACE) 1.0

* Wizard Mode- designed for automated SCAP content

generation of XCCDF wrapped OVAL SCAP content without
requiring users to fully understand XML, XCCDF, or OVAL. This
mode provides a limited set of features.

e« Standard Mode- considered an advanced feature, for
example, editing OVAL and XCCDF documents/files.




Malware Content
Editor (MACE) 1.0

* Purpose:

To provide step-by-step instruction on how to
create an SCAP data stream (OVAL, XCCDF,
CPE - Dictionary.xml, and CPE- OVAL.xml)
to search for and discover artifacts on an

operating system.



Malware Content
Editor (MACE) 1.0

 Per National Institute of Standards and
Technology (NIST) 800-126

« SCAP Data Stream
1. OVAL.xml
2. XCCDF.xml
3. CPE- Dictionary.xml
4. CPE- OVAL.xm|



« PART 1 - Create SCAP Data Stream for a
Single OVAL file.

« PART 2 - Create SCAP Data Stream for
Multiple OVAL files.



PART 1

OVAL Creation
for a File



OVAL Creation
(for a file)

.' C:\Users\Administrator\Desktop\TIP

Organize *  Indude in ibrary -

0 Favorites
B Desktop
4. Downloads
=] Recent Places

B Desktop
= Libraries

Share with -

Burn  Mew folder

=]
[ ==
[ =]
[ =]

TIP 10-030-U-testl-cpe-dictionary. xml
TIP 10-030-U-test1l-cpe-oval.xml

TIP 10-030-U-test1-owval xml

TIP 10-030-U-test1-wccdf, xml

Create SCAP Data Stream for a Single OVAL check



OVAL Creation
(for a file)

% x|

Please choose which mode you would like to start in:
~Modes

Starts the editor in wizard mode. This mode asks you
some guestions and produces content based on your answers.
Mo need to know OVAL or XCCDF technology.

Standard Starts the editor in standard mode. This mode allows
you to create OVAL and XCCDF content directly.
Requires you to know OVAL or XCCDF technology.
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OVAL Creation
(for a file)

Malware Content Editor{Wizard EI

Target OVAL version
1 OVAL_53 -

OVAL Mamespace Identifier
2 | [ooD.DiB.gov

What would you like to create?

ol

File{unix) - Creates file /directory related content.
Reqgistry - Creates windows registry related content.

11



OVAL Creation
(for a file)

E Create New windows File Test x|
What to check about file | SavE content I

Platform windows

TIP 10-030-U favorites.dat, variable path, MD5

[T Regex  Edit |

Yecommenprogramfiles % Edit |
Hecommonprogramfiles (x86) %

Yehomedrive %
#homepath e
Yeprogramdata ¥e
Heprogramfiles®e e
Heprogramfiles(x&5) %e

—File detail

£ Must exist and meet the following criteria

path(STRING)
filename(STRING)
owner(STRING)
size(INT)

a_time(INT)
c_time{INT)

m_time (INT)
ms_checksum(STRING)

. =l
MED STORN

Added
Edit
Remove
| Pane 1 of 2 Back I Mext Cancel

12



OVAL Creation
(for a file)

What to check about file | SaVE Content |

Platform windows

Title
|‘I'IP 10-030-U favorites.dat, variable path, MD5
Path

|c:\, 7| I Regex it |
/EHETTEHTE\
\Iw [ Regex = Edit |

curse to find file(s)/directory(ies)

< Direction Idown vl Depth -

rFilEfBirExistence

* Exists ™ Doesn't Exist

rFile detail

{~ Must exist and meet the following criteria

path{STRING) B Add
filename (STRING)

owner{STRING)

size(INT)

a_time(INT)

c_time(INT)

mi_time{INT)

ms_checksum(STRING) LI

e cinnWED STOIRY

Added

Edit:

Remove

Page 1 of 2 Back: | MNext | Cancel |

13



OVAL Creation
(for a file)

ECreate New windows File Test
What to check about file | Save content I

Platform windows
Title

|TIP 10-030-U favorites.dat, variable path, MD5
Path

IC:'lI j [~ Regex  Edit |

Filename

| favorites.dat [~ Regex  Edit |

¥ Recurse to find file(s)/directory(ies)

own Depth IUnIimihed 'l

\_File/Dir Existence

" Exists " Doesn't Exist
—Fi il
b File detail Z x|
\L*¥ Must exist and meet the following criteria Datatype STRING
e VEOpTEN T CEEE s TRIG] Operation I ‘I @
company (STRING) m S——
internal_name(STRING)
language(STRING) Data
original_filename{STRING) ICSAD3523C8426 107 18Aff32AE7453fde Regex |
product_name(STRING)
product_version{STRING) 0K Cancel
sha1(STRING) [ |
Added
Edit
Remove

Page 1 of 2 Back | Cancel |
——

14



OVAL Creation
(for a file)

Create New windows File Test |
What to check about fie Save content |
Overview

Please choose a filename for your new OVAL content. If you choose an existing file it will be overwritten. An accompanying XCCDF document will also be
created that references the checks you created in the OVAL content.

Filename must end in "-oval.xml
Browse

sons 00k T [ ET S x
| | TIP 10-030 ~| [

@

Recent Items

-

Desktop

My Documents

i!;

Computer

r’ i
Ay Fiename: (TP 10-030-U-test1

-
Metwaork Files of type: IAII Files LI Cancel ;l:lsa\"e

Page 2 of 2 Back Firiish | Cancel |

15



OVAL Creation
(for a file)

gCreate New windows File Test x|
What to check about file Save content |

Overview
Please choose a filename for your new OVAL content. If you choose an existing file it will be overwritten, An accompanying XCCDF document will alsa be
created that references the checks you created in the OVAL content.

Filename must end in "-oval. xml'
| Wsers\Admiristrator\Desktop TIP 10-030{TIP 10-030-U-test1®
Status The file name is valid,

Page 2 of 2 Back |( Finish | ) Cancel |

16

ccdf automatically generated




OVAL Creation
(for a file)

& Malware Content Editor{Wizard @

Target OVAL version

QVAL Mamespace Identifier
|poD.DIB.gov

What would you like to create?

File{windows) - Creates file/directory related content. Go!
File{unix) - Creates file /directory related content.
Registry - Creates windows registry related content.

17



PART 1

OVAL Content
Verification

18



OVAL Content
Verification

| | TIP 10-030 x| [

88 TIP 10-030-U-test1-oval.xml

Recent Items

My Documents

A

Computer

E ™ Filename:  |TIP 10-030-U-test1-oval.xml
e p—

DR Flesof type:  [ovaL fies =] Cance| |Open

In Standard Mode 19



OVAL Content
Verification

Malware Content Editor 1.0
File Tools Help

& | =

£ OVAL Document - C:\Users\Administrator\Desktop\TIP 10-030\TIP 10-030-U-testl-ovalxml

=101
Search l— Style |Default =l
, OVAL 5.3 Definitions Document{C: \Users\Adr ijectl Sourcel

J Definitions(1) b

a ” General
= vulnerability(1)

oval:DOD.DIB. gov:def: 1 - TIP 10 ObjectId  [oval:DOD.DIB.gov:obj: 1
N Tests(1)

Object Type filehash_object

, filehash(1) Version
oval:DOD0.DIE. gov:tst: 1 - File ha _
. Obgects(1) I 15

Comment |Check C: for files named favorites.dat

filehash(1) [ Use Behaviors
‘.4 oval:DOD.DIB.gov:ste:1 - Check

I
Behaviors

Behavior Imax_depih hd I Add

recurse_direction = down Edit
max_depth = -1

Remove

Structure for OVAL Object oval:DOD.DIB.gov:obj: 1
# Parameter(string | equals) path = Ct,

N . £l Edit
Remove
£ b

\ Expand All | Collapse all |
Messages
Level I Message

20



OVAL Content
Verification

Malware Content Editor 1.0
File Tools Help

_4|b|

£ OVAL Document -

:\Users\Administrator\Desktop\TIP 10-030\TIP 10-030-U-testl-ovalxml

=100
Search l— Style |Default |
| OVAL 5.3 Definitions Document(C: \Users\Adr smtel Source I

.| Definitions(1) ;

: L rGeneral

= wvulnerability (1)

oval:DOD.DIE.govidef: 1-TIP 1 | | StateId Joval:DOD.DIE. gov:ste: 1
K Tests(1)

State Type filehash_state
B . filehash{1)

Version
oval:DOoD.DIB.gov:tst: 1 - File ha lﬁ
|| Objects(1) =

| filehash{1)
oval:DOD.DIB.goviobj: 1 - Chedk | Comment ICheck files for mdS equals CSAD3523C84251D713Aff32AE7453fde
b States(1) ~Possible parameters
- |y filehash(1)
o . Parameter Ipatﬁ LI Add
The path element specifies the absclute path to & file on the machine. ﬂ
=l
~Added parameters
Mame Operation Datatype Qalue ) Edit
md5 equals string (C5AD3523C84261D718Af32AE7453FDE i
K 0
EBxpand Al | Collapse Al |
Messages
Level I Message

File > Save for any changes ’1



PART 1

OVAL Validation

22



OVAL Validation

lware Content Editor 1.

\dministrator\Desktop\TIP 10-030\TIP 10-030-U-testi-ovalxml
WAL Documents
SearT I Style IDefElult LI
Definitions Docl
] _?Eﬁ;?lo)nstl) ~General Details
) Tes
Objects(1) Filename: C:\Users\Administrator\Desktop {TIP 10-030TIP 10-030-U-test1-oval. xml
| States(1)
~OVAL Generator Details
Product Name MACE
Product Version 1.0
OVAL Schema Version 5.3
Timestamp 2010-08-16T11:43:38
K] 2
Expand All | Collapse all |
Messages
Level | Message

23



PR fabwiore Content Ednor 1.0

B OVAL Document

C:\Users\Administrator\Desktop\T1# 10 030\T11* 10- 030/ U testl oval

o =1
Style [Default =]
. o ] Definitions Doc |
(1] Definitons(1
(4 : Tests(1) General Detalls
- Objects(1) Fllename:  C:\Users\Administrator \Desktop\T1P 10-030\T1P 10-030-U-test 1-oval. xml
- States(1)
QVAL Generator Detalls
Product Name MACE
Product Version 1,0
OVAL Schema Vergion 5.3
tamp 2010-08-16T 11148138
JN [— | 3| on successiul x|
: = l = = l 0 Validation successful
. /N
teve_| E(E)
R

24



FA Malware Content Editor 1.0
1@ ools  Help

ZPE Dictionary

Save

Save As XCCDF

Recent ¥ 5CAP Data Stream
Wizard Mode

Exit

25



PR vamvin s Content Edinor 1.0

o =1
Style [Default =]
- o ] Definitions Doc |
(1] Definitons(1
(4 : Tests(1) General Detalls
[ Objectx(1) Fllename:  C:\Users\Administrator \Desktop\T1P 10-030\T1P 10-030-U-test 1-oval. xml
- States(1)
QVAL Generator Detalls
Product Name MACE
Product Version 1,0
OVAL Schema Vergion 5.3
tamp 2010-08-16T 11148138
JN [— | 3| 3 on successiul x|
: = l = 2 l 0 Validation successful
; N
Level | |

26



PART 1

Validate the Automatically
Generated XCCDF

27



XCCDF Validation

Malware Content Editor 1.0
File Tools Help

28



My Documents

0y

Computer
EP File name: |TIP 10-030-U-test1-xccdf, xml ‘
SRS Files of type:  |xCCDF Benchmark files | Cancel

29



XCCDF Validation

Malware Content Editor 1.0

— Co) Validation successful

30



PART 1

Create Additional SCAP
Data Stream files
(from the XCCDF)

31



Create the SCAP data
stream files

Malware Content Editor 1.0
|F|'E Tools Help

From XCCOF

Create a new CPE dictionary containing CPE i

Save XCCDF ]
Save As
Recent ]

Wizard Mode
Exit

32



Create the SCAP data
stream files

Generator element added |

This dictionary document didn't have a generator element.
One has been added, but you will need to dick "Save” or "Save As™ on the File menu
for these changes to be reflected in the on-disk version of this document.

33



Create the SCAP data
stream files

B ttabware Content tdntor 1.0
=191 ]
| Style [Cetauit |
Defrstars Dox |
+ :_:f::n{m o
+ o7 Doy
:, . Otmctsl®) Pleneme: Ci'Users Aanestratr \Deskton Time AHGe TP 10-0204U - Copy TIP 50-0 304 tews 1-coe-oivesl wri
|“ pp—
OVAL Genarater Detsis
Peodct Nare PRODUCT
Product Yerson Nia
OVAL Schwma Yorsen 53
Terestare 2000027510462 18 476 04:00
| K I | |
eosdal | ol | |
Messages

Validation successful 7 l(j

.
(0) Validation successful

34



Create the SCAP data
stream files

B Matware Comtent tdtor 1.0

Stybe [Oefatt =l
CPE Dictionry |
Teemadé Gorwral Dwtade -
Fanarse:  C-\ners|Admrmy wior DeshtopTine AYsde TP 102900 « Crgay (TH7 10-0304)-tawd Lpeicssnary, wmi
CFE Gontator Ostals =
Product Neme [aro-generated croduct cave
Frodxt Yermen 'h.uw-ul-: roduct vwrsen
CPE Schenla Version 2.2
Terestamp Wed Sep 01 043506 POT 2010

Validation successful i ﬂ

(@) Validation successful

35



Create the SCAP data

stream files

' C:\Users\Administrator\Desktop\TIP

O =

- (&

Organize *  Indude in ibrary -

0 Favorites
B Desktop
4. Downloads
=] Recent Places

P Desktop
- Libraries

Share with -

Burn  Mew folder

=]
[ ==
[ =]
[ =]

TIP 10-030-U-test1-cpe-dictionary. xml
TIP 10-030-U-test1l-cpe-oval. xml

TIP 10-030-U-test1-oval. xml

TIP 10-030-U-test1-xccdf, xml

36



PART 2
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OVAL Creation
(for aregistry entry)

Please choose which mode you would like to start in:
~Modes

Starts the editor in wizard mode. This mode asks you
some guestions and produces content based on your answers,
Mo need to know OVAL or XCCDF technology.

| Starts the editor in standard mode. This mode allows
you to create OVAL and XCCDF content directly.
Requires you to know OVAL or XCCDF technology.

38



OVAL Creation
(for aregistry key)

9 Malware Content Editor{Wizard P

Target OVAL version
1| fovaL_s3 =

OVAL Mamespace Identifier
2| |pop.omB.gov

What would you like to create?
3

File{windows) - Creates file /directory related content.
File{unix) - Creates file/directory related content.

Legistry - Creates windows registry related content.

39



OVAL Creation
(for aregistry key)

x|
Registry Hive/KeyMame I Bave content)|
e
|TIP 10-030-U hive, key, name & va@
r is tp be tested
" Hive\Key exists - ignore Name and Value
" Hive\Key does NOT exist - ignore Mame and Value
{ Hivefey\Name exists - ignore Value
~ HiveKey\Name does NOT exist - ignore Value
(foalue of hivelkeyiname
rRegistry Hive
IHKEY_LOCAL_MACHINE =
—Registry Key
ISOFI'WARE \WMicrosoft\Active SetupiInstalled Components|{687E990C-31CE-2A70-1FAF-EAFATE 20D 79}] I~ Regex Edit |
rRegistry Mame
Stub Path [~ Regex  Edit |
~Registry Value
I‘E-‘.:System%'n,kjset.exe Edit |
Datatype: Ish’ing ;I Operation: quuals LI

Page 1 of 2 Back: |g MNext 3 Cancel |

40



OVAL Creation
(for aregistry key)

zl

| |, TIP 10-030 ~| [

|| TIP 10-030-U-test1-oval.xml
|| TIP 10-030-U-test1-xccdf.xml

Recent Items

My Documents

A

Computer

E’ Flename: TP 10030 Uffest2 )
M Fiesof type:  [alFies ~| Cancel |

41



OVAL Creation
(for aregistry key)

Malware Content Editor(Wizard Qil/

Target OVAL version

WAL Mamespace Identifier
|poD.DIE.gov

What would you like to create?

File(windows) - Creates file/directory related content. 5ol
File{unix) - Creates file/directory related content.
Registry - Creates windows registry related content,

42



PART 2

OVAL Content
Verification — Reqistry
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Veri

OVAL Content
fication — Registry

R rtabware Content tditor 1.0

=10
sty o £
| Js OvaL 5.3 Defortons DoaunersiCiLsers\Aah | Obgect| Socecs |
= ,_:)e‘homsf.x. ) Goweral
= 4 vuneraddty{l)
@ 0w DO DT.gondet 1 TIP & | | el w000 018 gonzobt: L
b Tesn(l) Clysct Type  segtry_sdsect
1 regary(l) Verson
@ ovDO0OIS goryitae: 1 - Defind -
- b Ctjecta(y) I _E_
= s regatry(t)
( :_ Coremant Ec’.llumml. plesse change
T 3% regull) T~ ke Betaniors
& oveiDOD 018 goviste: | - Defay Behaviars
Behwicr [rax_ceom ~] Ase l
cture for OVAL Coject ovstDOD.DIB, paveody: &
Pes anter (3UNg | eguais) hwe = HEY_LOCA MACHNE
Parareter (Mg | egeds) koy = SOFTRARE MassoNActe Satupinstaled Conporenty\[B27E200C.8105 24N IFAF EAFATSXO0M)]
: 2

44



OVAL Content

Verification — Reqistry

¥ OVAL Document - C\Users \Administrator \Oesktop \TIP 10-030)\TIF 19-030-U- best2 evalonl

ssted Style [oefor =l
b O 5.3 Defintions DocumentiC: LUsers'ad m',,,”'
= Defrvtons{1) ) ; "
= Winerabity (1) |
(B cvsDOD D12 govidet: L - T 11 State 1¢ Jorral DO0.0(B gore:ate: 1
-4 Tests(y) State Type fegoyy_state
=1 repetre(t) Verson
® ovaiDOD DIB.govitst: 1 - Defad || I.—-l-a;
- Otgecs(1) | |
= regetre(l)
® 04000 215.gov ot - Defau | Commant [Defat conment, sesse dange
-y Stotes(t) - Pegstie py aveters
8% '5Mtlllil

m P

2w |

ifIha hive that =hs seQlistey key Selongs te. TRis 13 sesrsisted oo & speclflic set af valuss)
||[REEY CLASSEZ BOCT, EMEY CURRENT COWYIG, MKEY CUSSENT USER, EREY LOCAL MACHINE, s BEEY USERS,

=

4

3l
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A OVAL Content
&2 Verification — Registry

Validation successful x|

@ Validation successful

46



PART 2

Validate OVAL File
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Save As

Recent ¥ 5CAP Data Stream
Wizard Maode

Exit

48



TIP 10-030-U-test2-oval.xml

My Documents

iy

Computer

Flename:  [TIP 10-030-U-test1-oval.xml

Bl Fiesof type:  [ovaL fies E2 Capeet 1 0per

49



Validate OVAL File

B Malware Content Editor 1.0

\dministrator\Desktop\TIP 10-030\TIP 10-030-U-test1-owvalxml
- Merge OVAL Documents

SearaT I

Style IDef—cluIt

Definitions Docl

+ Definitions(1) ~General Details
| Tests(1)

Objects(1) Filename: C:\Jsers\Administrator\DesktopTIP 10-030YTIP 10-030-U-test 1-oval.xml
| States(1)

—~OVAL Generator Details

Product Name MACE

Product Version 1.0

OVAL Schema Version 5.3

Timestamp 2010-08-16T11:43:38

K] [— I
Expand All | Collap=ze all I
Messages
Level I Message

50



>
= I— stvie [oatat =]
, Owhriesare Duc |
¥ 4 Defrvtorw(1)
b Tesw(D Gore w Detak :
M b Cépecss(i) C: s - AP Am. a
= States(() s U0 -seat Lol
OVAL Ganerstir Detaie
Frnduxt Hane
Prococt Verssm 10
OVAL Schesnn Yergon 6.3
Timestans 3010-00-36T [1:40:38
Vabdatemn s crwshil
- 1 =
Escerst AN I Curllagens 24 ] | E
] ﬁ

o1



***|f you have additional reqistry checks then you will
repeat these steps for all additional registry checks.

***|f you have additional OVAL Checks for files follow the
steps in the previous section to generate, verify and
validate each OVAL. Repeat these steps for any
additional OVAL checks for files. The remaining slides
will indicate how to merge all OVAL files and produce the
FINAL OVAL.xml, FINAL-XCCDF.xml , FINAL-CPE-
Dictionary.xml, and FINAL-CPE-OVAL.xmlI files

52



PART 2

Create FINAL-OVAL.xm|
by Merging Multiple OVAL
files
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Create FINAL-OVAL.xml
by Merging
Multiple OVAL files
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Create FINAL-OVAL.xml
by Merging
Multiple OVAL files

OVAL Merger ]
Select files to merge

Remmue
el
[
Recent Items
Desktop
My Documents
A
Computer
File name: |P 10-030-U-test1-oval.xml™ "TIP 10-030-U-test2-oval.xml™ m
<
Files of type: | ovaL files =] Cancel |

| 0%

Merge | Cancel

55



Create FINAL-OVAL.xm|

by Merging

Multiple OVAL files

Select Browse
& name FINAL

Select files to merge

OVAL Merger

TIP 10-030-U-test1-oval xml
ITIP 10-030-U-test2-oval, xml

IVWrapper Definition Options:

Definition amespace |

£~ With Wrapoer Definition
Save

Add...

Remove

Save in: I & TIP 10-030 LI
| TIP 10-030-U-test1-oval.xml

@- || TIP 10-030-U-test1-xcedf, xml
nt ITtems | TIP 10-030-U-test2-oval.xml
|| TIP 10-030-U-test2-xcedf, xml

Desktop

My Documents

)

nputer

File name: TP 10-030-UFINA oval xml

Fies of type: [l Fiies |

)

56



Merged OVAL
Validation

Malware Content Editor 1.0

e— Co) Validation successful

S



PART 2

Create the FINAL
XCCDF.xml from the
FINAL OVAL.xml
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(& Vo
CPEDctonary ¥
B i w5 \TIP 10-0301 TP 10-030-31-TINAL-vs =ioixl
e - wdl SINTTIE 30 BUe- A T
Swoa o Sty [Defast =1
_ Recear » N | Detl Create & new ACCOF Berchrnark from an exnting OVAL document |
> Genersl Detads
ot Hemare C:LmeyiAdrer wir Deskan TP 10-030T11P 10-0304) #1NAL oo wsd
4 Staves(T
AL Ceneratoe Detade
Product Name: PRODUCT
Froduct Verson i
VML Scheve ¥erson 3.3
01058 1610104:18
‘ |
Bows A l ot A |
e | Message |
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Create the FINAL
XCCDFEF.xml from the FINAL
OVAL.xml

IR toniware Content frdtne 1.0

Style |Oefauit

= (53 . Ve 7 1003073 10-030-UFINAL oval e

| OVAL Gerwrate Detals
Product Name PRODUCT
Product Verson NiA
OVAL Schwma Veteon 5.3
Tmestang 2010-08-16TO L0418

Profie wie
[P 1000 uFNA

3
ages Fr%!;n 03|
e | m o

Gensrate

—'\ﬁ&vgsanlccr' benchmark for each o the Fles sbove. =
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B Create the FINAL
%)) XCCDF.xml from the FINAL
OVAL.xml|

Validation successful x|

@ Validation successful

61



PART 2

Create the additional SCAP
data stream files from the
FINAL-XCCDF.xm]
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From XCCDF

Create a new CPE dictionary containing CPE i

Save XCCDF 3
Save As
Recent 2

Wizard Mode
Exit
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Generator element added |

This dictionary document didn't have a generator element.
One has been added, but you will need to dick "Save” or "Save As™ on the File menu
for these changes to be reflected in the on-disk version of this document.
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File > Save > Tools > Validate > Close xml
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reate SCAP data stream files

G shena verson 23
rstara Ve Ses 03 05:04.38 90T 205
=} |
' | Coluge |
Messoges
el | Message |

File > Save > Tools > Validate > Close xml
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' C:\Users\Administrator\Desktop\TIP 10-030

G- | -wam-

Organize «*  Incudeinlibrary «
- Favorites

B Desktop

& Downloads

=l Recent Places

Bl Desktop
- Libraries
@ Documents
J? Music
gﬂ Mew Library
|5 Pictures
B8 videos
A Administrator
;-;l Computer
SVR2008 (C:)
. DVD RW Drive (D:)
%% DVD Drive {F:) Enc-Trickler-01
5 DVD Drive (G:)
?ﬂ Netweork

1M WIN-295C9CM3TIV
ire= IR

Sharewith =  Burn  New folder

MName « Date modified Type Size
| TIP 10-030-UFINAL-cpe-dictionary. xml 8/19/2010 11:43 AM XML File
|| TP 10-030-U-FINAL-cpe-oval. xml 3/19/2010 11:43 AM XML File
| TIP 10-030-U-FINAL-oval.xml 8/16/2010 1:02 PM %ML File

|1} TIP 10-030-U-FINAL-oval.zip
|| TIP 10-030-U-FINAL-xcccdF.xml
L TIP 10-030-U-test1-oval.xml
|| TIP 10-030-U-test1-xcedf, xml
L TIP 10-030-4-testZ-oval.xml
|| TIP 10-030-U-test2-xcedf. xml

8/19/2010 11:44 AM
8/16/2010 1:16 PM

8/16/2010 12:13PM
8/16/2010 11:43 AM
8/16/2010 12:47FPM
8/16/2010 12:47PM

Compressed (zippe...

XML File
XML File
XML File
XML File
XML File

iew Folder
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POC'’s

« Tina Ackerman, DoD
410-854-0692

*Mike Kinney, DoD
m.kinne@radium.ncsc.mil

« Shane Shaffer, G2
shane.shaffer@g2-inc.com
s.shaffe@radium.ncsc.mil
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THE DECISIVE ADVANTAGE
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